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2 GETTING STARTED

Fast Start
This Network Implementation guide contains instructions on how to setup 
your AccountEdge Network Edition product.

Follow the tasks below to install and begin using your software.

For information on support plans, see ‘Support Options’.

For information on payroll services, see ‘Payroll Options’.

Task See

1 Network with AccountEdge Network Edition page 3

2 Set up your AccountEdge network page 5

3 Install your software page 9

4 Start FileConnect page 10

5 Set up a company file for multiple users page 12

6 Open a company file page 15

7 Maintain your company file over the network page 18

8 Maintain company file access with FileConnect page 23
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Network with AccountEdge Network 
Edition

AccountEdge Network Edition is designed to run on a simple 
network made up of a few computers.

AccountEdge Network Edition is recommended for use on a peer-to-
peer network.

On a peer-to-peer network running AccountEdge, the company file 
(the file which contains your business’s financial data) is stored on 
one of the computers in the network. This computer is referred to as 
the host computer, and it must be accessible by the other computers 
on the network, known as workstations. 

The host computer does not need to be a dedicated computer (like a 
server), it can be any computer in the network. Note that all 
computers in an AccountEdge network must be using Mac OS X 
10.10 or higher. 

Securing your network for AccountEdge Network Edition 

AccountEdge Network Edition assumes that your network will be 
protected by an Internet Firewall, if your network is connected to the 
Internet. You do not need to make changes to your Internet firewall 
to use AccountEdge. 

If you use a personal firewall on your host computer, however, you 
will need to ensure that the firewall is configured to allow 
AccountEdge data to pass from workstations to the host. 

AccountEdge does not use a preassigned port number for the 
transmission of data from workstations to your company file on the 
host computer. Therefore, any port between 49152 and 65535 can 
be used to transmit data to your company file. 

You can choose to specify a particular port number in that range for 
your AccountEdge activity (but the port must not be closed by a 
personal firewall), or you can simply allow AccountEdge’s 
FileConnect system preference to dynamically assign a port for you. 
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Multi-user data entry

AccountEdge Network Edition enables multiple users to work on 
your company file simultaneously, from different workstations. This is 
ideal for businesses that have a large volume of daily transactions. 

If you set up AccountEdge on a network, you can add, change or 
delete information, print reports and perform analysis functions at 
the same time as your coworkers.

When you purchase AccountEdge Network Edition you receive a 
single license at the time of purchase. However, you can easily buy 
additional licenses (known as workstation licenses) to install the 
software on additional computers. 

Faster data transfer

To prevent a slowing of data transfer between the host computer 
and the workstations AccountEdge has FileConnect. 

FileConnect is a system preference that’s automatically installed 
when you install AccountEdge Network Edition. FileConnect’s main 
purpose is to permit and streamline the transfer of AccountEdge data 
between workstations and your company file on the host computer. 

Company file maintenance is centralized

You need to backup, verify and optimise your company file regularly. 
You can perform all of these tasks from either the host computer or a 
workstation. 

For further information regarding maintenance of your file see 
‘Maintain your company file over the network’. 

Now that you’ve learned a little about how AccountEdge Network 
Edition works in a network environment, you are ready to set up your 
network. 
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Set up your AccountEdge network

Minimum system requirements

Your system must meet the minimum system requirements in order 
to run AccountEdge Network Edition. 

NOTE : Hardware and Software requirements will vary depending on your 
operating system.

Operating 
system

Mac OS X 10.11 to 10.14

Hardware Intel-based Mac with 2GB RAM or more
250 MB available hard disk space for program 
installation
Minimum of 35 MB available hard disk space for each 
company file
1152x720 screen resolution with thousands of colors

Network Wired Ethernet network: 100Base-T or faster 
Airport wireless network: Airport Extreme Cards 
installed on all computers
Airport Exteme Base Station
TCP/IP must be enabled on all computers

For Better 
Network 
Perfomance

Intel Dual Core i5 or faster processor with 4GB RAM 
and SSD drive added for hosting company files is 
highly recommended
1000BaseT/Gigabit Ethernet Wired Network 
Mac OS X 10.13 or 10.14

Internet Required for accessing program updates, payroll 
updates and forms, and Online Help

Officelink Office 2008 or 2016
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System performance

 Be sure your computers all meet (or exceed) the minimum 
system requirements for AccountEdge Network Edition. 

 Upgrade your computers' operating systems so all computers are 
using the same version of Mac OS X. By doing this, you’ll lessen 
the amount of work a computer must perform to receive 
information from other computers on the network. 

 Try to keep at least five to 10 percent of the size of your hard disk 
free. The more free disk space on a computer, the faster its 
performance. In addition, when a hard disk has very little free 
space, it’s possible that files - including your AccountEdge 
company file - can become fragmented on the disk. 

Computer memory

 Although AccountEdge can run on computers with less than 1GB 
of RAM, you’ll find that increased amounts of memory will 
improve your system’s performance. If possible, upgrade your 
computers to exceed the minimum RAM required.

 If you’re planning on running additional programs while 
AccountEdge is running, we recommend that you purchase 
additional RAM.

Network maintenance

 The faster your network, the faster AccountEdge will send and 
receive messages across the network. If you are using a 100 MBps 
Ethernet network, we recommend you upgrade to 1,000 MBps 
Gigabit Ethernet network.

 If you use a wired network, we recommend you use high-quality 
shielded twisted pair cable. 

 Keep your network components as clean and dust-free as 
possible.

 Try to minimize the traffic on your network when AccountEdge is 
in use. AccountEdge requires a significant amount of attention 
from the network when it’s recording and processing your 
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company’s financial data. If other programs are requesting 
network resources at the same time, you may experience slower 
performance in AccountEdge.

Choose a host computer
For networking, the company file needs to be stored on a host 
computer to which each user has access. In choosing a suitable host 
computer, consider the following:

 Host the company file on the most powerful computer in the 
network Network performance is enhanced if the company file 
is stored on the fastest computer with the most memory.

 Host the company file on a network server If your company 
employs a server running special server software such as Mac OS 
X Server, consider hosting the company file on the server. Servers 
are faster and are specially designed to handle network traffic.

 Host the company file on the key employee’s computer If 
one employee will use AccountEdge more than anyone else, 
consider storing the company file on that employee’s computer. 
This person may experience better performance from accessing 
the company file directly, compared with accessing it across the 
network. 

 Host the company file on a backup computer If you store all 
your important files on a central host that is backed up 
frequently, it is a good idea to also store your company file on 
that host. Then the company file will be backed up with all your 
other vital data. 

Constraints on host computers

You can run AccountEdge on a host computer and use the company 
file on that computer, but users on workstations accessing the same 
file may discover that their system is slower than usual. 

If you encounter this situation, here are some solutions:

 Upgrade all your computers to a recent release of Mac OS X, and 
be sure they’re all using the same version. This will take advantage 
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of the latest networking features of Mac OS X and streamline the 
communication among computers. 

 Try to perform processing-intense tasks—such as printing 
documents or installing software programs—on the host 
computer only when others do not need access.

Choosing how to identify the host 
computer
The host computer requires some sort of identification so 
workstations can locate the company file that resides on its hard disk. 

You have two methods from which to choose to identify the host 
computer. One, by using Bonjour to see the host’s name or two, by 
using the host’s IP address. You can also use a combination of the 
two methods. (Note that Bonjour was called Rendezvous in earlier 
version of Mac OS X). 

Use Bonjour if you want to keep things simple

In a network that uses Bonjour, any workstations running 
AccountEdge can use Bonjour to locate the company file simply by 
knowing the host computer’s name. Assuming the users have the 
appropriate access rights to the company file, the users will be able 
to open and work with the company file without needing to know 
any other details about the host computer. To determine the name of 
the host computer on your network, see To view a computer’s name, 
below.

CAUTION : Bonjour cannot be used in some network situations If 
you have a network that incorporates multiple subnetworks (subnets) 
and the host computer is on a different subnet than your workstations, 
you won’t be able to use Bonjour. 

To view a computer’s name to see the name of a computer, open 
the System Preferences and click Sharing. The computer’s name is 
displayed near the top of the window. 



   INSTALL YOUR SOFTWARE 9

Install your software

To install AccountEdge Pro(Mac) or AccountEdge Network 
Edition (Mac)

1 If your computer allows only users with administrator privileges to install 
programs, log in as an administrator. 

2 If you are upgrading from an earlier version of AccountEdge Network 
Edition, stop FileConnect:
a Go to your Mac OS X System Preferences.
b Click the AccountEdge icon in the Other section of the System 

Preferences window. The AccountEdge system preferences appear.
c Click Stop FileConnect.
d Enter the Administrator password and click OK.

3 Double-click the downloaded AccountEdge ProDMG file to mount the 
disk image. The Finder appears, displaying the disk image contents. 

4 Double-click the AccountEdge Proinstaller file located on the disk image.

5 Follow the onscreen instructions to install AccountEdge Pro.

NOTE : Installing AccountEdge Network Edition If you are installing 
AccountEdge Network Edition on the host computer for the first time, 
do not customize the installation. This ensures that all critical 
components are installed. 

6 When the installation is complete, if prompted click Restart. Your 
computer will restart.

7 For each workstation in the network, repeat from step 1 above.

NOTE : You need to run FileConnect on only the host computer.

8 On the host computer, Start FileConnect.
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Start FileConnect

FileConnect is the system preference that enables network 
connections between the workstations using AccountEdge Network 
Edition. FileConnect must always be running on the host computer 
while you are using AccountEdge Network Edition.

When you installed AccountEdge Network Edition, FileConnect is 
automatically added to your system preferences. 

To start FileConnect

NOTE : You only need to run FileConnect on the host computer

1 Launch the System Preferences from the dock. The System 
Preferences window appears. 

2 In the Other section of the window, click the AccountEdge icon. 
The AccountEdge system preferences appears.

3 Click Start FileConnect to turn FileConnect on. After a moment, 
the text on the button will change to Stop FileConnect, which 
indicates that FileConnect is now running.

4 Click the Port Number tab. 
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5 Decide if you want to use a specific port to allow AccountEdge 
workstations to access the company file on the host computer, or 
if you want to allow FileConnect to choose a port for you. 
 If you want to use a specific port, enter the number of the port 

you wish to use in the Port Number window. 
 If you want to allow FileConnect to assign a port, or if you will 

be using Bonjour to access your company files, leave the Port 
Number field at zero. This indicates the port used to transmit 
AccountEdge data will be dynamically assigned by 
FileConnect; that is, a different port number may be used for 
AccountEdge each time FileConnect is restarted. 

 If you will be using a direct IP address to access your company 
files, enter a port number between 49152 and 65535 in the 
Port Number field. This will ensure your workstations will 
access the company file using this particular port on the host 
computer.
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Set up a company file for multiple 
users

All the accounting information - your company’s transactions and 
other important business records - that are entered in AccountEdge 
for a single company is stored in a company file. Before you can 
begin using AccountEdge, you must create a company file. 

You can create a company file using the AccountEdge program on 
either the host computer or any of your workstations. 

When you finish creating the company file, it is automatically placed 
in a specific folder on your network’s host computer that will allow 
access by your workstations. 

To create a new company file

The New Company file assistant simplifies the process of creating a 
company file. If you need additional information about each step as 
you proceed through the Assistant, click the Help button at the 
bottom of any window.

1 In the Finder, locate the AccountEdge application folder. 

2 Double-click the AccountEdge NE icon. The Welcome to 
AccountEdge Network Edition window appears. 

3 Click the Create button to create a new company file. The first 
step in the AccountEdge New Company File Assistant appears.

4 Follow the on-screen instructions until you reach the Create your 
company file window.
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5 In the Create your company file window, click Browse. The New 
Company File Browser window opens. 

6 Select a method for identifying the location where you will store 
your company file on the host computer. 

To identify the host computer using Bonjour
a Click Bonjour. The name of the host computer should appear 

in the Hosts list. 
b Click the Host name to select it. 

To identify the host computer using the IP address
 Click IP Address and enter the IP address and port number of the 

host computer in the IP Address and Port # fields. 
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For more information about identifying the host computer, see 
‘Choosing how to identify the host computer’ on page 8.

7 Enter a name for your company file in the Save As field, then click 
Save. The Create your company file window reappears, 
displaying the name or IP address of your host computer along 
with the name of your company file. 

8 Click Next. The company file is saved on the host computer to 
the Library/Application Support/AccountEdge NE/Databases 
folder. 

9 If you want to continue setting up your company file, click Setup 
Assistant. You can use the Easy Setup Assistant to help you 
through the main company file setup tasks. 

10 If you want to set up your company file later, click Command 
Center.
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Open a company file

Once your company file is created, you can open it from any of the 
networked computers that have AccountEdge installed. You can 
open a company file using the Finder or by using a connection 
document.

To open a company file by browsing for it

1 In the Finder, locate the AccountEdge NE application folder. 

This is the folder that was created when you installed 
AccountEdge NE. For example, if you installed your software in 
the default location, the folder location will be Applications/ 
AccountEdge NE. 

2 Double-click the AccountEdge NE icon. The Welcome window 
appears.

3 Click the Browse button. The Company File Browser window 
appears.

4 Select the method you use to locate the host computer on the 
network, either Bonjour or IP Address.

5 If you want to locate the company file using Bonjour:
a Click Bonjour. The name of the host should appear in the 

Hosts list. 
b Click the host’s name to select it. The company files residing on 

the host computer will be displayed in the Company Files list.
c Select the company file you want to open.

6 If you want to locate the company file using the IP address:
a Click IP Address. The IP address options appear.
b Enter the IP address and port number of the host computer in 

the IP Address and Port # fields, then click List Files. The 
company files saved to the host computer appear in the list. 

c Select the company file you want to open.
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7 Click Open. The Sign-on window appears.

8 Complete the Sign-on window and click OK. The company file 
opens.

To create a connection document for a company file

You can simplify the process of opening a company file on the host 
computer by creating a connection document on a workstation. A 
connection document is a shortcut file that retains the information 
about your company file’s location on the host computer. You can 
place the connection document in a convenient location on your 
workstation, such as the desktop. You can then double-click it to start 
AccountEdge and open your company file.

NOTE : Connection documents replace aliases A connection document 
is similar to an alias, which is another type of Mac shortcut file. However, you 
cannot use an alias to open a company file on a host computer. If you wish to use a 
shortcut, you must use a connection document.

1 In the Finder, locate the AccountEdge application folder. 

This is the folder that was created when you installed 
AccountEdge NE. For example, if you installed your software in 
the default location, the folder location will be Applications/ 
AccountEdge NE. 

2 Double-click the AccountEdge NE icon. The Welcome window 
appears.

3 Click the Browse button. The Company File Browser window 
appears.

4 Select the company file for which you want to create a 
connection document. Select the file in the Bonjour or IP 
Address tab of the window, depending how you access the 
company file.

5 Click the Save Connection button at the bottom of the 
Company File Browser window. The Save window appears.

6 Enter a name for the connection document in the Save As field.

7 Choose where you want to store the connection document by 
making a selection from the Where list. We suggest that you save 
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the document on your desktop, where you can later drag it to the 
Dock for easy access.

8 Click Save. The connection document will appear in the location 
you selected with the name you entered. Note that the name of 
the connection document will be displayed with a ‘.connect’ 
suffix.

NOTE : Using FileConnect with DHCP If the computer or server that is 
hosting company files and running FileConnect is set up with DHCP where an IP 
address is dynamically assigned, your IP address may change from time to time. In 
this case, your Connection Document may need to be recreated. 

To open a company file using a connection document

1 Locate the connection document and double-click it. 
AccountEdge starts and the Sign-on window for the company 
file appears.

2 Complete the Sign-on window and click OK to open the 
company file.
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Maintain your company file over 
the network

To help ensure the integrity of your financial information, you should 
perform regular maintenance on your company file, including 
backing up, verifying, and optimizing your company file. 

Perform maintenance tasks on the host computer We 
recommend you perform maintenance tasks on the host computer. 
Performing these tasks on a workstation can take longer and network 
interruptions may disrupt the processes.

Enable single-user file locking for maintenance tasks Only one 
user should have access to a company file during file maintenance 
procedures. For example, optimizing a company file rearranges its 
internal structure, so ensure that the file is not being accessed while 
this process is taking place. 

Single-user file locking prevents all but the first logged-in user from 
accessing a shared company file—other users cannot log in. 

TIP : View a list of users To check whether any other users are 
currently using the company file before you set a single-user lock, go to 
the File menu and choose Active Workstations.

To enable single-user access after starting your software, click Single-
user access in the Sign-on window.

Back up company files
If multiple users access a company file, you need to back up the 
company file on the host computer—including custom forms, 
letters, and spreadsheet templates you have created. You can then 
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copy the updated templates to each workstation and ensure the 
latest versions are used. 

To back up a company file

1 Open the company file you want to back up.

2 Make sure no other users are logged into the company file.

3 Go to the File menu and choose Backup. The AccountEdge 
Company File Backup window opens.

4 Choose the type of backup you want:
 To back up your company file and templates, click Backup all 

data.
 To back up your company file only, click Backup Company 

File only.

NOTE : Customized documents stored on workstations will not be 
backed up If you’re using the host computer to back up your files, any 
custom letters, forms, and spreadsheets stored on the workstations on the 
network will not be included in the backup. You will need to back up these 
items separately on your workstations.

5 Choose whether to check your company file for errors by 
selecting one of the options. 

6 Select a location option for your backup: 
 To back up to your local disk, to a different hard disk, or to 

other media, select To a Disk.
 To back up to a Dropbox account, select Dropbox. 

Note that before you can back up to Dropbox, you must have 
a Dropbox account. For more information about Dropbox 
accounts, see the Dropbox website.

7 Click Continue.

8 If you selected the Check Company File for errors option, the 
verification process may take several minutes.

When the verification process finishes, click OK in the window 
that appears. Note that this window appears whether or not 
errors have been found in the company file.

The Back Up window appears.

https://www.dropbox.com/login
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9 Specify where you want to store the backup file.

A default filename is assigned: 

10 If you want, you can change the name of the backup file. Note 
that you should name your backups with enough information to 
tell you when they were from and where you were up to in data 
entry—for example, ‘Monday 010714’ or ‘Backup as of 010714’.

11 Click Save. The backup process begins.

12 If you are storing the backup files on a removable storage device, 
label them clearly, so you know exactly when the backup was 
done. 

Verify company files
Data verification is the process of checking a company file for errors. 
Verification can catch minor problems in the file before they cause 
serious problems. You can verify your company file at any time. We 
recommend you do this on the host computer.

To verify a company file

1 Open the company file you want to verify.

2 Make sure no other users are logged into the company file.

3 Go to the File menu and choose Verify Company File. A 
message appears, describing the data verification process. 

4 Click OK to confirm that you want to verify your company file. 
Your company file is scanned for errors. 

Default filename Description

Backup mm-dd-yyyy 
filename.zip

• mm-dd-yyyy is the date from your computer’s 
clock

• filename is your company file name
• .zip is the file extension and cannot be 

changed.
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When the file verification process is complete, a message appears 
describing the results of the process. 

If no errors were found, click OK to end the verification process. 

If your company file is corrupt, you can:
 Attempt to fix the company file by optimizing it—see 

‘Optimize company files’ on page 21—and then repeat from 
step 1 above to check if the errors have been fixed.

 Restore the company file from your most recent backup—see 
‘Backing up and restoring company files’ in online help. 

5 Click OK.

Optimize company files
As you enter transactions, then remove or purge them, your 
company file will have unused areas that once contained these 
transactions. These unused areas can affect the efficiency of your 
company file and take up space on your hard disk. 

You can use the Optimization Assistant to remove the unused areas 
in the company file and keep your software running efficiently.

You can optimize your AccountEdge data file at any time. We 
recommend you do this on the host computer.

To optimize a company file

1 Open the company file you want to optimize.

2 Make sure no other users are logged into the company file.

3 Go to the File menu, choose Optimize Company File. An 
information window appears.

4 Click OK to continue. The Optimization Assistant window 
appears.

5 Click Continue. The Open a Company File window appears.

6 Locate the company file and click Open. The optimization 
process begins.
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When the process is finished, a window will appear, confirming 
the company file has been optimized. 

7 If you want to optimize another company file, click Continue and 
repeat from step 6.

8 Click Close.
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Maintain company file access 
with FileConnect

The following information will help you prevent interruptions to your 
workstations’ access to the host computer. 

To restart FileConnect on the host computer

If FileConnect quits unexpectedly, you will need to restart it. When 
you restart the system preference, review the port settings to be sure 
they are accurate.

1 Log in to the host computer as an administrator.

2 Go to the apple menu and choose System Preferences. The 
System Preferences window appears. 

3 Click the AccountEdge icon. A control panel window appears.

4 Click Start FileConnect to turn FileConnect on. After a moment, 
the text on the button will change to Stop FileConnect, which 
indicates that FileConnect is now running.

5 Check that your access ports are set correctly:
 If you allow FileConnect to assign a port, or if you use Bonjour 

to access your company files, leave the Port Number field at 
zero. This indicates the port used to transmit AccountEdge 
data will be dynamically assigned by FileConnect.

 If you use a direct IP address to access your company files, or if 
you use a specific port number, enter the port number 
between 49152 and 65535 in the Port Number field. Your 
workstations will access the company file using this particular 
port on the host computer.
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Prevent the host computer from sleeping
When other users are accessing the company file on the host 
computer, you should not allow the host computer to go into sleep 
mode. Follow the steps below to prevent a computer from going to 
sleep.

To prevent the host computer from sleeping

1 Log in to the host computer as an administrator.

2 Go to the apple menu and choose System Preferences. The 
System Preferences window appears. 

3 Click Energy Saver. 

4 If you are using the battery select the Battery tab, if you are using 
a power adapter select the Power Adapter tab, then drag the 
top slider to Never.

5 Deselect the Put the hard disk to sleep when possible option.

6 Close the window.

To stop FileConnect on the host computer

Once FileConnect is running on the host computer, you should not 
turn it off. If you do need to turn off FileConnect, follow the steps 
below. Note that users will not be able to access your AccountEdge 
company file if FileConnect is not running.

NOTE : All workstations need to be logged out of company files
FileConnect will not stop unless all workstations are disconnected from your 
company files. To check whether any other users are currently using the company 
file, go to the File menu and choose Active Workstations.

1 Log in to the host computer as an administrator.

2 Go to the apple menu and choose System Preferences. The 
System Preferences window appears. 

3 Click the AccountEdge icon. A control panel window appears.
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4 Click Stop FileConnect to turn FileConnect off. After a moment, 
the text on the button will change to Start FileConnect, which 
indicates that FileConnect is no longer running.

5 If you receive an alert message when you try to stop FileConnect, 
a user may still be logged into a company file. Make sure all 
workstations are logged out of the company files and repeat this 
procedure.

Check for software updates
To make sure you are using the current version of your accounting software, 
you should check every so often to see if any updates or upgrades are 
available.

To check for updates using a Mac computer, open your company file, then go 
to the AccountEdge Pro menu and click Check for Updates.
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Support Options

Introductory Support Free for 30 days after product registration for new 
users who have recently purchased. During this period, our Support team will 
offer assistance with installing your accounting software and setting up your 
company file.

You can call Introductory Support at 877.206.8808 between 9am - 6pm 
(Eastern Time), Mon - Fri.

Email Support You can always submit a support case online at 
accountedge.com/help. 

Concierge Calls Schedule a free one-on-one consultation at Schedule a 
consultation.

Need More? 

Telephone Support Buy an annual telephone support plan to get the 
answers you need when you need them. Telephone Support offers expert 
phone support from our support staff. 

For more information or to enroll, visit accountedge.com/support or call 
Customer Service at 800.322.6962.

Technical support is limited to installation, upgrade assistance, basic usability, and basic functionality. 
We cannot resolve issues caused by third-party services, service providers, hardware, software, or 
networking problems. Technical support is limited to the current version software and two versions 
back. Phone support does not cover inquiries on general accounting or taxation issues, nor does it 
include application consulting or training.

http://www.accountedge.com/support
http://accountedge.com/help
https://app.acuityscheduling.com/schedule.php?owner=14097601&appointmentType=3988647
https://app.acuityscheduling.com/schedule.php?owner=14097601&appointmentType=3988647
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Additional Support Resources

Certified Consultants Certified Consultants are independent computer or 
accounting professionals who demonstrate a high level of knowledge, skill, 
and experience with AccountEdge. Certified Consultants can assist you with 
installing, setting up, and using your accounting software. They can also 
provide product demonstrations and on-site training.

To find local help, visit accountedge.com/locator. 

Self Help A variety of Self Help options are available under Get Help Online 
located in the Help menu of your product or visit accountedge.com/support.

Payroll Options

Payroll Tax Services Enroll in one of our Payroll Tax Services to make sure 
you have the most recent payroll tax updates. As a Payroll Tax Service 
member, you also receive any upgrades to AccountEdge that are released 
during your membership term. 

Payroll Tax Services are available with or without software support.

For more information or to enroll, visit accountedge.com/payroll or call 
Customer Service at 800.322.6962. 

https://www.accountedge.com/locator
http://www.accountedge.com/support
http://www.accountedge.com/payroll
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Acclivity LLC
Website: accountedge.com 

© Acclivity Group LLC 2019

All rights reserved.
Acclivity Group LLC End User License Agreement

This is an agreement (the “Agreement”) between you, the end user, and ACCLIV-
ITY GROUP LLC. “Software” is defined as the ACCLIVITY computer program and 
user documentation that is included with this Agreement and any updates or 
maintenance releases related thereto. By installing and/or using this Software you 
agree to become bound by the terms of this agreement. Do not use the Software 
until you have carefully read this Agreement.   

IF YOU AGREE WITH THE TERMS OF THIS AGREEMENT, CLICK THE “ACCEPT” or 
“AGREE” BUTTON WHILE INSTALLING THIS SOFTWARE.  IF YOU DO NOT AGREE 
TO THE TERMS OF THIS AGREEMENT, DO NOT USE THIS SOFTWARE. PROMPTLY 
REMOVE IT FROM YOUR COMPUTER. You may then return the entire package and 
your receipt within 30 days to the place from which you obtained the Software for 
a refund of the purchase price. Until return of this package has been accepted, you 
are governed by this Agreement.

This Software is protected by copyright laws and international treaties and may 
only be used in accordance with the License terms and conditions.

TRIAL VERSION SOFTWARE LIMITATION. If this Software is a trial version it has 
restrictions on its use and is intended to be used only for evaluation purposes. This 
software may be used for 30 days as of the first time you run the software. Upon 
lapse of such period the software will disable automatically. If you wish to use the 
software after the tryout period, you need to purchase and activate a Commercial 
License for continued use.  Upon your purchase of the full version Software prod-
uct license and acceptance of the terms and conditions of the software license 
agreement accompanying the full version software product, the restrictions in this 
paragraph (Trial Version Software Limitation) shall no longer apply, but the 
remainder of this Software License Agreement shall remain in full force and effect, 
and in the event there is any conflict between this Agreement and the full version 
software license agreement, the full version software license agreement shall con-
trol.

LICENSE  Subject to the terms of this Agreement, Acclivity Group LLC grants to 
you, the original purchaser, a royalty-free, non-transferable (except as specified 
below), non-exclusive License (the “License”) to use the Software, unless other-
wise agreed to in writing by ACCLIVITY as follows: 

Online Activation
The Software requires online activation and registration in order to use the Soft-
ware under the terms of the License. If you do not activate your copy of the Soft-
ware, your copy of the Software will disable automatically 30 days after you first 
install the Software.

You are required to enter personal information during online activation. You need 
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an active, functional internet connection to activate your copy of the Software. 
Your licensed use of the Software is bound to the computer(s) you used to com-
plete activation. You may need to reactivate your copy of the Software after 
replacing the logic board of your computer or otherwise changing the hardware 
configuration of your computer. You may need to contact Acclivity to complete 
reactivation.

This License does not allow the Software to be activated and used on more com-
puters than the number of computers you have purchased Licenses for.

Numbers of Users.   
Single Site License.  You may install and use the Software on only one computer 
that you own or operate and must not use or permit the usage of the Software on 
more than one computer or by multiple users unless additional licenses are pur-
chased.  Additional licenses are required for each user accessing the software by 
way of ASP/terminal servers/web clients or other remote connection. You may 
transfer the Software and its License from one such computer to another that you 
own or operate provided that you Deregister your software and Reactivate. In 
event of an upgrade or product exchange, the license hereby granted shall auto-
matically transfer to the new version or products, but you will be required to Acti-
vate such upgrade.   
Additional Licenses. You may install the software on the number of computers 
that you have purchased Additional Licenses for. Additional licenses can be pur-
chased for your business from Acclivity to allow multiple installations and for 
simultaneous user access to accounting files across a network. Additional Licenses 
are also required for each user accessing the software by way of ASP/terminal ser-
vices/web clients or other remote connections. One license shall apply to
one individual named user within your legal entity. Additional Licenses can be pur-
chased for use on computers used remotely, by the original purchaser only.

Updates and Upgrades. In the event of an upgrade, update or product exchange, 
the license hereby granted shall automatically transfer to the new version or prod-
uct. All rights in respect of the original product shall lapse and no further use of 
these shall be permitted.
Archive Copies. You may not copy or duplicate the Software, except as necessary 
solely for archival purposes, Software error verification, or to replace defective 
storage media, provided you keep the original and the copies. You may not alter, 
decompile, or disassemble the Software. You may make copies of the user docu-
mentation up to but not exceeding the number of multi-user licenses you have 
purchased.
Copies. You may not copy or duplicate the Software or this Trial Version Software 
and distribute it to others for their evaluation, except as necessary solely for archi-
val purposes, program error verification, or to replace defective storage media. 
You agree to retain the Software and all such copies in your possession.
Restrictions Transfer.  You may not lease, sublicense (including offering the Soft-
ware to third parties by means of ASP/Terminal Servers/Web Client or other 
means of Remote Access), rent, lend, distribute or otherwise transfer or assign the 
Software, Licenses, Additional Licenses, Product Updates, Payroll Tax Updates or 
any lawful copies thereof, except that you may transfer all of your rights and inter-
est in and to the Software, including any upgrades and additional licenses pur-
chased, to a single person or entity (“Transferee”), provided that (i) you either 
transfer to the Transferee any and all copies you may have made or destroyed said 
copies upon transfer of the Software, so that you retain no copies, (ii)  that you 



30 GETTING STARTED

transfer to the Transferee any and all manual(s) which were provided by ACCLIV-
ITY pertaining to the Software,  (iii) the Transferee agrees to be bound by the 
terms of the Agreement, and (iv) you notify ACCLIVITY in writing of such transfer, 
and provide the name and address of the Transferee.
Term and Termination. The License is effective until terminated. You may termi-
nate the License at any time by removing the Software from your computer and 
destroying any copies you have of the Software. The License is automatically ter-
minated if you violate any portion of this Agreement. You agree upon any such 
termination to destroy the Software together with all copies. Upon termination, 
there will be no refund of any monies paid by you except in connection with the 
30-day return policy set forth above. Termination of this License shall be in addi-
tion to and not in lieu of any other remedies available to ACCLIVITY.
Protection and Security. You agree to use your best endeavors and to take all rea-
sonable steps to safeguard the Software to ensure that no unauthorized person 
has access to the Product and that there is no unauthorized copying or distribu-
tion of the Software or user documentation. 
 
UPDATES AND CONTINUING  FULFILLMENT If ACCLIVITY elects, in its sole discre-
tion, to produce subsequent updates and revisions to the Software (collectively, 
“Product Updates”), you may receive such Product Updates as they become avail-
able for your licensed version of the software. Payroll Tax Updates which include 
changes to payroll tax, withholding calculations, and payroll tax tables are pro-
vided as a service and additional fees apply for such service. Updates are delivered 
online. All Updates are subject to the terms of this License.

COPYRIGHT PROTECTION  Except as set forth in “LICENSE” above, you may not 
copy or use the Software, and any copy that you make as permitted by this Agree-
ment must contain the same copyright and other intellectual property notices 
that appear on or in the Software. The Software is protected by United States and 
International copyright or other intellectual property law. ANY USE OF THE SOFT-
WARE, EXCEPT AS EXPRESSLY PERMITTED IN THIS LICENSE AGREEMENT, MAY 
SUBJECT YOU TO CIVIL DAMAGES AND LEGAL FEES, AND MAY BE A SERIOUS 
CRIME. 

CONFIDENTIALITY  The Software constitutes Confidential Information and con-
tains trade secrets of ACCLIVITY.  You are not permitted to disclose the Software 
to any third party except in accordance with this Agreement.  You may not reverse 
engineer, disassemble, or decompile the Software, payroll tax tables or other 
related files, or otherwise attempt to discover the source code of the Software.  

TRADEMARKS Trademarks shall be used in accordance with trademark law, includ-
ing identification of trademark owners’ goods and services.  Trademarks can only 
be used to identify printed output produced by the Software, and such use does 
not give you any rights of ownership in that trademark.

TAX TABLES YOU ASSUME FULL RESPONSIBILITY FOR THE SELECTION OF THE 
PAYROLL TAX TABLES AND SALES TAX TABLES (“TAX TABLES”)  WHETHER PRO-
VIDED BY ACCLIVITY OR OTHERS, TO ACHIEVE YOUR INTENDED PURPOSES, FOR 
THE PROPER INSTALLATION AND USE OF THE TAX TABLES AND FOR VERIFYING 
THE RESULTS OBTAINED FROM USE OF THE TAX TABLES. ACCLIVITY DISCLAIMS 
ANY WARRANTY OR CONDITION THAT THE FUNCTIONS CONTAINED IN THE TAX 
TABLES WILL MEET YOUR REQUIREMENTS OR THAT THE TAX TABLES OR THE 
OPERATION OF THE TAX TABLES WILL BE INTERRUPTION OR ERROR FREE. 
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PROFESSIONAL ADVICE  ACCLIVITY IS NOT ENGAGED IN RENDERING LEGAL, 
ACCOUNTING, OR OTHER PROFESSIONAL ADVICE OR SERVICE. IF LEGAL ADVICE, 
OR OTHER EXPERT ASSISTANCE IS REQUIRED, THE SERVICE OF A COMPETENT 
PROFESSIONAL SHOULD BE SOUGHT. IT IS YOUR RESPONSIBILITY TO KEEP 
INFORMED OF ACCOUNTING, TAX, AND/OR PAYROLL CHANGES THAT MAY 
AFFECT YOU AND TO ENSURE THAT YOU FOLLOW THESE CHANGES. 

LIMITED WARRANTY AS TO MEDIA  ACCLIVITY warrants that the media on which 
the Software is recorded is free from defects in materials and workmanship under 
normal use for a period of 30 days from the date of your original purchase. 

DISCLAIMER OF WARRANTIES  EXCEPT AS PROVIDED IN THE FOREGOING PARA-
GRAPH (“LIMITED WARRANTY AS TO MEDIA”), ACCLIVITY DISCLAIMS ANY AND 
ALL WARRANTIES TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW. 
THE SOFTWARE AND RELATED MATERIALS ARE PROVIDED “AS IS”. ACCLIVITY 
DISCLAIMS ALL WARRANTIES AND CONDITIONS, WHETHER EXPRESS, IMPLIED, 
STATUTORY OR OTHERWISE, INCLUDING WITHOUT LIMITATION, WARRANTIES 
OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR WARRAN-
TIES THAT THE PRODUCT IS FREE OF VIRUSES OR ERRORS OR WARRANTIES OF 
NON-INFRINGEMENT OF THIRD-PARTY RIGHTS.    ACCLIVITY DISCLAIMS ANY 
WARRANTY AS TO THE PERFORMANCE OF THE SOFTWARE OR AS TO THE 
RESULTS THAT MAY BE OBTAINED BY USING THE SOFTWARE. THE ENTIRE RISK 
AS TO THE INSTALLATION, USE, QUALITY, AND PERFORMANCE OF THE SOFT-
WARE IS WITH YOU. IT IS YOUR RESPONSIBILITY TO VERIFY THE RESULTS 
OBTAINED FROM USE OF THE SOFTWARE.
 
Some jurisdictions do not allow the limitation or exclusion of implied warranties, 
so the above limitation or exclusion may not apply to you. This warranty gives you 
specific legal rights and you may also have other rights which vary. This disclaimer 
of warranties and the limitation of liability below shall not be modified, dimin-
ished or affected by, and no obligation or liability will arise or grow out of the ren-
dering of technical, programming, or other advice or service, or the provision of 
support for the Software by ACCLIVITY.

LIMITATION OF REMEDIES  ACCLIVITY’S ENTIRE LIABILITY TO YOU AND YOUR 
EXCLUSIVE REMEDY SHALL BE THE REPLACEMENT OF ANY DEFECTIVE MEDIA 
(SUCH AS CD-ROM) RETURNED BY YOU TO ACCLIVITY WITH PROOF OF PUR-
CHASE DURING THE 30-DAY LIMITED WARRANTY PERIOD, AS SET FORTH ABOVE. 
IN NO EVENT WILL ACCLIVITY BE LIABLE TO YOU FOR ANY DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING BUT NOT 
LIMITED TO LOST REVENUES, DATA, PROFITS OR SAVINGS) ARISING OUT OF 
YOUR USE OR INABILITY TO USE THE SOFTWARE EVEN IF ACCLIVITY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL THE LIA-
BILITY OF ACCLIVITY ARISING FROM YOUR USE OR INABILITY TO USE THE SOFT-
WARE EXCEED THE FEE PAID BY YOU FOR THIS LICENSE. Some jurisdictions do not 
allow the limitation or exclusion of liability for incidental or consequential dam-
ages so the above limitation or exclusion may not apply to you.

AMENDMENT  ACCLIVITY has the right to change the terms of the End User 
License Agreement at any time.  Your continued use of the software after such 
changes constitutes your acceptance of this or a modified End User License Agree-
ment.   Please regularly review the End User License Agreement available on the 
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Acclivity web site for amendments, changes and additional terms.  ACCLIVITY also 
has the right to change, delete, remove, discontinue or change any feature, func-
tion, service or software at any time. Prices of the software, services and support 
may be changed at any time.

GENERAL  This Agreement will inure to the benefit of ACCLIVITY, its successors, 
and assigns and will be construed under the laws of the State of New Jersey, USA, 
except for that body of laws dealing with conflict of laws. If any provision of this 
Agreement is deemed invalid by a court of competent jurisdiction, such provision 
shall be enforced to the maximum extent permitted and the remainder will 
remain in full force. This Agreement is the entire agreement between you and 
ACCLIVITY in respect of the Software. 

PRIVACY  The Acclivity Privacy Policy can be found on www.accountedge.com/pri-
vacy. During product registration and activation, personal identifiable information 
is sent to Acclivity including your contact information. Acclivity may record, but 
not share, the following AccountEdge information, including: (a) serial number, 
(b) computer operating system, (c) product version, (d) feature usage as demon-
strated by the number of clicks on the respective AccountEdge modules, last trans-
action dates and number of records. Acclivity does not have access to your data 
file, nor does it collect information about  financial performance or any personally 
identifiable information about your customers, vendors or employees. Please 
review our Privacy Policy prior installing the software.

06/05/2019 Software License Agreement - Canada
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